Excel Formulae & Functions Quick Reference (PC)
See https://staff.brighton.ac.uk/is/training/Pages/Excel/formulae.aspx

Checking for formulae

for videos and exercises to accompany this quick reference card.

If you are using a spreadsheet set up by someone else, before typing data
into a cell, check whether the cell contains a formula.

Formulae & Functions Basics

If a cell contains a formula, the cell will usually show the result of the

When building a formula:

formula. The formula itself can be seen in the formula bar.



All formulae and functions begin with =



Use your mouse to select a cell or range of cells to be used in a formula



Click on the cell to select it.
The formula bar will display the content of the



The operators for building formulae are:
+

Add

*

Multiply

-

Subtract

/

Divide

selected cell.


If the cell does contain a formula, double click on the cell.
This will colour any cells on the current worksheet that feed into that



BODMAS rules apply to arithmetic (Brackets Over Division, then

formula, to help you work out what that formula does and how it works.

Multiplication, then Addition, then Subtraction).



Avoid typing variables (such as tax rates) in formulae; instead type the

Always press ESC to stop checking/editing a cell containing a formula.
This guarantees that you will leave the formula as you found it.

variable in a separate cell and refer to that cell in the formula
Do NOT click your mouse elsewhere on the sheet to stop checking as th is


To repeat a formulae down a column, build the formula in the first cell of

may break the formula.

the column, then use autofill to copy the formula down the column.

How to check which cells on a sheet contain formulae
There is a way to show all formulae on a worksheet before you start using it:

Functions follow the format =name(arguments) where:


name

= the name of the function (e.g. SUM, VLOOKUP)



arguments

=the cell or range references containing the values
used in the function

, (comma).
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On the Formulas tab, click on the Show Formulas icon



Any cells with formulae will show the formula instead of the result



To switch this off, go back to the Formulas tab and click on the Show
Formulas icon

Where a function contains more than one argument, each argument must be
separated by a



The shortcut for this is CTRL `
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How to check what a formula is doing

Building a formula to subtract

Use this technique to check that your formulae are doing what you think:


Click on the cell containing the formula.



Click once on the formula in the formula bar.



The cells used in the formula will be colour coded within the sheet,

1. Click in the cell where the result of the formula will appear

2. Type =

making it easy to spot mistakes.

3. Click on the first cell containing data to be included in the calculation

Building a formula to add

4. Type –

1. Click in the cell where the result of the f ormula will appear
2. Type =
3. Click on the first cell containing

5. Click on the next cell containing data to be included in the calculation
6. Press ENTER on the keyboard.

Building a formula to multiply or divide

data to be included in the sum
4. Type +

1. Click in the cell where the result of the formula will appear

5. Click on the next cell containing
data to be included in the sum
6. Repeat steps 4 and 5 as required.
7. Press ENTER on the keyboard.

2. Type =
3. Click on the first cell containing data to be included in the calcul ation

Autosum to add row or column totals

4. Type * to multiply or / to divide

This only works where the total is to appear at the end

5. Click on the next cell containing data to be included in the calculation

of the column or row of data. This technique will not

6. Press ENTER on the keyboard.

work across worksheets.




Select the range of cells to add up
On the Home tab, click on the Autosum

icon

The total will be put in the cell at the end of the selected cells.
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Useful keyboard Shortcuts

Autofill to copy formula to other cells

Using your keyboard to navigate saves time when building formulae.
CTRL + Arrow keys

 Select the cell(s) you want to copy. The fill

Jump to the beginning, end, top or bottom of a set of

handle will appear at the bottom right of the

data.
CTRL + SHIFT +

selection

Select an entire column

 Point at the fill handle until it becomes a cross.

Down arrow



Click and drag to copy the data OR Double-click to autofill all rows

Select an entire row



Click on

CTRL+A

Select all data (one cell in data set must be selected)



Always double-click on some of the newly populated cells to check that

CTRL + SHIFT + *

Selects an entire data table

CTRL + SHIFT +
Down arrow

to change the type of fill (series, copy, formula only etc.)

the copied formula is still doing what you expect.
If your copied formula is not behaving as it should, it is likely that your
original formula references a single cell that should be used in all of the

Use insert function (formula builder) to make
formulae easier


Start to type your formula until the first bracket e.g. =VLOOKUP(



On the formula bar, click on the function button



The pop-up window splits the formula into its arguments



To select cells to add them to the formula click on the

formula. In this case, you will need to make the cell reference absolute. See
Absolute references for common variables for more information.

Relative cell references
icon to jump

When you use the autofill technique to copy a formula down a column or

back to the worksheet. To return to the formula builder after selecting

across a row, Excel will automatically update the cell references in the

cells click on the

formula, relative to where the copied formula sits.

icon again.

Copied down the column…

Copied across the row…

A2

…becomes A3

…becomes B2

A3

…becomes A4

…becomes B3

A4

…becomes A5

…becomes B4

Cell reference
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Absolute references for common variables
Avoid typing variables (such as tax rates) in formulae; instead type the
variable in a separate cell and refer to that cell in the formula.

$$ signs to make a cell reference absolute
The alternative to naming a cell is to use dollar signs within the cell
reference to make the cell reference for the variable value absolute.A quick
way to do this:

The advantage of this is that, should the variable change, you only need
update one cell and all formulae referencing that cell will updated
automatically.



Click on the cell containing the formula



Click once on the cell reference in the formula bar



Press F4 to add 2 dollar signs to your cell reference. Eg D2 will become
$D$2.

The disadvantage is that if you copy a formula that references that variable
cell, your formula will not work properly unless you make the referenc e to
the variable cell absolute (instead of relative)

You can type the dollar signs in manually.

Mixed cell references
When copying formulae to other cells, sometimes you only want to

There are 2 ways to make a formula absolute (which you choose is up to
you):

anchor the column letter or row number of a cell reference within the
original formula. This is achieved by changing the position of the dollar



Naming the variable cell



Using $ signs to indicate that a cell reference is absolute

Name cells or ranges for easier to read formulas
This technique has the advantage that formulae become easier to read.
The disadvantage is not many people understand the technique.

signs mentioned above. A quick way to do this:


Click on the cell containing the formula



Click once on the cell reference in the formula bar



Press F4 until the cell reference meets your requirements (see below)

Relative v absolute v mixed cell references
This table shows how the different $ sign positions affect the cell



Select the cell or range you want to name



Click in the Name box (left of the formula bar)



Type the name and press ENTER

references in a formula when copied:
Original cell
reference...

...when copied
becomes

To use, simply type the name wherever you would use a

D2

E4

cell or range reference in a formula. e.g. =SUM(Wages)

$D2

$D4

D$2
$D$2
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E$2
$D$2

Effect
Both the column and the row coordinates change
as the formula is copied
The column coordinate is fixed, but the row
coordinate changes
The column coordinate changes, but the row
coordinate is fixed.
Both the column and row coordinates remain fixed
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Function
SUM
AVERAGE
MAX
MIN

IF

Used for
Add values in a
range of cells
Average the values in
a range of cells
Find the highest
value in a range of
cells
Find the lowest value
in a range of cells
Display different
information
depending on the
outcome of a
condition test

Format

Example

=SUM(range of cells to add)

=SUM(A1:A10)

=AVERAGE(range of cells to average)

=AVERAGE(A1:A10)

=MAX(range of cells)

=MAX(A1:A10)

=MIN(range of cells)

=MIN(A1:A10)

=IF(condition test, what to display if
outcome is true, what to display if
outcome is false)

=IF(A1>20, “Great!”,”Oops!”) or
=IF(A1>20, A1*E1,A1)

Test that more than
one condition is true.
AND

Test result is TRUE
only if all conditions
are met.

=AND(condition test 1, condition test 2, ...)

=AND(A1>20,B1=”Gold”)

=OR(condition test 1, condition test 2, ...)

=OR(A1>20,B1=”Gold”)

Tips

TRUE and FALSE are the
only possible answers.
To change the content of
a cell as the result of an
AND function, use the
AND function as the
condition test in an IF
statement

Test that more than
one condition is true.
OR

Test result is TRUE if
any of the conditions
are met.

COUNT

Count numerical cells

=COUNT(range of cells to count)

=COUNT(A1:A10)

COUNTA

Count cells

=COUNTA(range of cells to count)

=COUNTA(A1:A10)

COUNTBLANK

Count empty cells

=COUNTBLANK(range of cells to
count)

=COUNTBLANK(A1:A10)

COUNTIF

Count cells that meet
a certain condition

=COUNTIF (range of cells to count,critera

COUNTIFS

Count cells only if
multiple conditions
are met

=COUNTIFS( range of cells for criteria
check 1, criteria 1 to satisfy, range of cells
for criteria check 2, criteria 2 to satisfy,...)

to satisfy)
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COUNT does not count
cells containing text, use
COUNTA for this

=COUNTIF(A1:A10,”>20”)
Counts all cells containing a value greater than
20
=COUNTIFS(A1:A10,”Gold”,B1:B10,”>20”)
Counts number of rows where column A contains
the word Gold AND column B is greater than 20

Can use pivot table instead.
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Function

Used for

Format

Example

SUMIF

Add values in a
range only if cells
meet a certain
condition

=SUMIF(range of cells for criteria check;
criteria to satisfy, range of cells to add)

=SUMIF(A1:A10,”Gold”,C1:C10)
Adds all cells in column C if column A contains
the word Gold

SUMIFS

Add values in a
range only if cells
meet multiple
conditions

=SUMIFS(range of cells to add, range of
cells for criteria check 1, criteria 1 to
satisfy, range of cells for criteria check 2,
criteria 2 to satisfy,...)

=SUMIFS(C1:C10,A1:A10,”Gold”,B1:B10,”>20”)
Adds all cells in column C if column A contains
the word Gold AND column B is greater than 20

Tips
You only need the second
range if the range to add
is different to the range to
be searched.
Can use pivot table instead

VLOOKUP
Where several spreadsheets use the same data, it is useful to have one sheet holding that data and then allow the other sheet s to reference that information
using the VLOOKUP function. This allows you to maintain data centrally. Any updates will automatica lly update the other sheets.

Main data sheet

The format of the VLOOKUP function is:
=VLOOKUP(lookup value, table range holding the master data, number of the column containing the answer to your question, FALSE)
For example, in the diagram above cell D2 would contain:

When using VLOOKUP for numerical data, you can omit FALSE from the

=VLOOKUP(C2,Main_data_sheet A2:D4, 3,FALSE)

function to find the closest match (next lowest value):

to search the table on the right, for the relevant fee for course code UB200.

=VLOOKUP(lookup value, table range holding the master data, number of
the column containing the answer to your question)

FALSE tells excel to only find an answer if an exact match is found for the
lookup value.

For VLOOKUP to work, the data table must be sorted in ascending order on

If no match is found (e.g. course code UB150), Excel will display #N/A.

the lookup column (e.g. the course code column A in the example above)
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Flash Fill (Excel 2013 & 2016 only)

To split the contents of a column into 2 columns

This tool is amazing for working with text in databases. In earlier versions,

For example, you can separate a column of full names into first and last

you needed to know several text functions to achieve the same results.

name columns.



Type the desired result in the first cell of the series and press ENTER



Insert a new column to the right of the column you want to spl it



Start typing the desired result in the second cell in the series.



Select the column that you want to split

Excel should suggest content for that and all other cells in the column.



On the Data tab click on the text to columns icon

Press ENTER to fill the column.



In the pop-up window, check that Delimited is selected and click on



Next
Some examples:



In the Delimiters section, indicate what separates the first bit of text from
the second.

To merge first name and last name in one column

o

E.g. if a space separates first and last name, click on Space



Type the full name in the first cell of a new column

o

The example shows how to indicate that 2 pieces of



Start typing the full name in the second cell of the

information are separated by a hyphen
o

new column


Click on Next and then on Finish

Press ENTER when Excel suggests the full name for
every cell in the column

To extract the initials from 2 columns


Type the initials in the first cell of a new column



Start typing the initials in the second cell of the new
column



Press ENTER when Excel suggests the initials for
every cell in the column

TOP TIP: if the technique above does not work:


Type the desired result in the first cell of the series and press ENTER.



Type the desired result in the second cell in the series and press
ENTER.



Select both cells.



Use the Autofill technique to copy the cells down column.



Click on the

icon and choose Flash Fill.
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Colour all cells containing a formula (Excel 2013
only)

Recommended PivotTables (Excel 2013 and 2016)

This may help you keep track of where

formulae. From Excel 2013 on, the Recommended PivotTables tool will

you have added formulae to a sheet.

suggest simple Pivot Tables to summarise your data without the need to

Excel Pivot Tables summarise data without the need to build complex

know the details of how to build a PivotTable.


Click on

to select the entire

choose New Rule.





In the list, click to choose Use a



worksheet.




On the Home tab, click on Conditional Formatting and

formula to determine which cells

Click on the Recommended PivotTables icon.

Click on the suggested PivotTables on
table in more detail.

In the formula box type
=ISFORMULA(A1)



Click on the Format button.



Choose the format you require. e.g. to
colour all cells containing a formula:



Click on the INSERT tab.

the left of the pop-up window to see the

to format


Click anywhere within the table of data.

o

Click on the Fill tab

o

Click on a colour for the cell

o

Click OK.

Click OK.



To create a PivotTable, click on the
PivotTable you require and click OK.



The PivotTable will be created on its
own worksheet.

Creating a chart from a Pivot Table
Once you’ve created a simple Pivot Table using the steps above, creating a

All cells containing a formula will be

chart to go with it is easy:

coloured.



Click on the Pivot Table to select it.



On the Pivot Table Tools ANALYZE tab, click on the PivotChart
icon
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Choose a chart type



Click OK.
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